Flip Book Maker for Word
Create Amazing Page-flipping eBooks with DOCs

User Documentation

Note: This product is distributed on a ‘try-before-you-buy’ basis. All features described in this
documentation are enabled. The unregistered version will be added a demo watermark.

About Flip Book Maker for Word

If you want to show your Word Documents or OpenOffice Documents in a fresh and popular way,
converting DOCs to Page-flipping eBooks could be a good choice.

Flip books, no longer simple illustrated books for children, but also refer to the e-books which
combine page-flipping effect with electronic technology. This brand new publishing mode is
changing the way how the 'common' people will receive and view information. Normally by just
clicking the page on your computer screen, then you can flip and read the pages as reading real
ones. It looks really innovative and you can use it for your presentation.

And program Flip Book Maker for Word is powerful enough to convert your DOCs to such kind of
eBooks with ease.

Flip Book Maker for Word is flexible software to convert Microsoft Word documents or
OpenOffice documents to stunning page-flipping eBooks. The program can be used for all levels of
users without any programming knowledge needed. It will perfectly integrate your Word or
OpenOffice pages with life-like page turning effect into a new look eBook to be published,
emailed, stored as standalone EXE format or even with burned to CD.

With using Flip Book Maker for Word, you can build your style eBooks using the dozens of preset
templates and adjust more than 50 kinds of settings yourself. You are able to use your favorite
background images, sounds, titles, exe logos, you can control book size, font, font and tool bar
buttons, you can even choose a hard or soft cover, right to left flipping and auto flipping to
present your DOCs in an interactive way.

After designing style for your page-flipping eBooks, you can choose a proper way to output:
"HTML" is for publishing online, "ZIP" can be much easier for emailing, "EXE" is an intergraded
format for quickly viewing, "Burn to CD" to output your digital books directly on CD-ROM.
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Detail features:

® Convert Microsoft Word documents to page-flipping eBooks.
® Convert OpenOffice documents to page-flipping eBooks.

® OQutputin 4 different formats: HTML, EXE, Zip and Burn to CD.
HTML allows you to upload to a website to be viewed online.
EXE and Zip allow you to send to your user by email to be viewed on their computer.
Burn to CD allows you to burn to disk so you can send out with physical media.
® Make a Mobile Version at the same time.
® Define your language for flash.
® Preview the output effect instantly.
® Provide multiple templates (default provided or download from website).
® Select render engine to output higher quality page-flipping ebook.
® Define mobile version quality.
® Import bookmarks (outline) with Word, and edit them manually.
® Import text so that text is searchable, define the minimum search characters.
® Set eBook size, choose landscape or portrait.
® Add password to protect your page-flipping eBook.
® Define titles, keywords and other metadata.
® Add Google Analytics Support.
® Define titles, icon, window size for EXE page-flipping eBooks.
® Define eBook margin size.
® Insert background music either for continuous play (loop) or for a set duration.

® Set background color and image.
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® Set eBook reading from right to left (for Right-to-Left languages such as Arabic).
® Choose hard cover for eBooks.

® Set page-flipping to manual or automatic.

® Set permissions for downloading, printing, sharing, Home button and more.

® Set colors and position (Top/Bottom) for toolbar.

® Set scale for zoom-in function.

® Set control bars to "show" or "hide" in full screen.

® Set the bookmark panel to show on left or right side.

® Set links to open in same or new window.

® Save and Load your project.

® Export and save settings for future use.

Using Flip Book Maker for Word

Flip Book Maker for Wordcan be started either by launching the application via the desktop short cut,
or directly from Windows Explorer. Start the program, you will see the below initial window:
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The file in the processing interface is an example file.

There are some main interfaces you will see while using Flip Word as below shows: Application Options,
Import Word, Template Settings, Language Option and Output. You can enter into each page to get clear
instructions for every detail option.

I. Application Options Interface

1. Render Engine Option

Flip Book Maker for Word provides 3 different render engines for you to create higher quality
page-flipping eBooks, click "Options->Application Options" to enter into "Render Engine" interface:
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o b
Render Engine | Create Mobile Version |

Flease selecte a render engine for the conversion

[SWF
@ SWF
F
[ 55
(1 GPL Ghostscript  Dowload Ghostscript
F
[ LIT |

(70 Inner Library
r

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality

Inner Library: Faster convert speed

ok | [ concl

SWF: Much legible characters, smaller output size
GPL Ghostscript: Higher color transfer quality
Inner Library: Faster convert speed

(Change option when Word imported failed)

2. Create Mobile Version Option

Five types of "Quality And Size":

Pages Quality and Size

Quality And Size:

High quality large file size
Medium quality medium file size
Low quality small file size
Lower quality smaller file size

High values ¢
A but require m
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Il. Import Word Interface:

{21] Import Word ==X
Source VWORD Flie
Browse.. | l Open it ‘
The Page Ranges to Import Watermark
@) All pages LY Place a custom text or image
B it rane: emmole 13,583 #, e Watermark{Stamp) to the file(s)
¥
|¥] Quickly import (Only impeort 10 pages to initial preview) | Set Watermark
Page Quality
Quality And Size: IHigh quality large file size hd
A% High values produce better page quality but require more disk space and more time to download.
[ 7] impart bookmark [Z] tmpart links [T]Enable search
Import Now Cancel |

Panel Description:

1. Source WORD File

Browse, .

Click this icon to open the Word file you want to convert;

Open it

2. The Page Ranges to Import

@ Al pages
Convert all pages to page-flipping eBooks;

View content of added Word file to clarify before converting.
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@ Custom range:  2-5 Example:1,3,5,9-21 .
Convert a range pages to eBook;

[ Quickly impart {Only impart 10 pages to initial preview) ) . )
Preview applied effect on first 10.

3. Watermark

oet Watermark Add image or text watermark to flipping pages.

[7] Applying Watermark Check this option first to choose default stamps or add new ones:

JJaca et wotermark it

% Add Text Watermark
Texthame
tame:  Text Watermark

Taxt: - Fage-figprg cock

Page-tiipping eBook

@]

Edit / Lo
Add text stamp fts

Add image stamp-_Jiads image watermaek
Add Image Watermark
Delete inage e

Name:  [mage Waiermerk
Move down e el

P ¢ X B ¥

Move up P
Wi 4 a Heghts 51 =

it mars @ e = |
Image Effact

Opacty: 0% T 1%
Rotator: 0 T degree 7| & background

Postion in margng Margns.
i Ylue
el = : -
L ™ i
o e s B
a

| Mameters

4. Page Quality

There are five types of "Quality And Size":
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figh, guality darge file gize.

Higher guality larger file size

A

Low quality small file size
Lower guality smaller file size

5. Other Options

[#] tmport bookmark . . . . . R
If your WORD file contains bookmarks, check this option to use in output page-flipping

eBook;

If your Word file has links, check this to enable in flipbook;

¥ Enabl ch . . . - .
e o Check this option to enable search functionality in created flipbook.

At last, click

icon to enter into template setting interface.
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lll. Template Settings Interface:

[ w040 1o FippmgBooerepiietd] - COPRrwROR e i

| T Cooven Qptions Help

[ reorworo | €8 appty chanoe | Hi; Gomvert To Fipping Book

| Desgn Setong | Bockmark
Ternplanes www.Fipaulder.com  Pages:

’ Flaat = H ’;‘

Passe customize The Alash tempiate here

| BBosk .
Bosk Title s Featuras:
wt Bk Frasie Bar ray
Rt ths Bk 82 CENLEY  Vad
(SR S

Fage o3
Fage Resght 104
Tep Margn m
Settom Margn [
wefi Margn 1 A
Right Margn 0
Flarsh Window Coir W00 et b b, b i
Page Background Color [l
EiPage Shadow
Ledt page Shadow ] g i
Right page Shadow N | [ e [ e o e
Fage Shadow Opecity
Eiftackgnound Confiy

Elfadground
Chuter Backgrourd Pie
Badground position | Scake B St
Tnnes Background Fie C:¥Progrand...

Tool Bar
E'Sd | Tosi Bar sategs.

The program provides three different templates at present: Classical, Float and Spread.
Each template contains some unique settings, the below instructions will show you details.

The design setting interface contains below main parts:
Choose Template

Book

Sound

Tool Bar

Initial Show

Bookmark

Language

Security Settings

Panel Description:
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1. Choose Template
Templates

‘ Iff Classical ‘H E&

Please customise the ﬂésh template here

ﬂ Classical ‘E|

Click icon to select templates from below interface:
{2 | metict » Tomphute i
| hoose 8 fipbook kemplsde here. [Double-chok fo ke & quick’ sebecbon]
# More and mos tenplates will b provided o fuiuee.)
ol More Theses Onine
|} S
| Tempiaties
="
| EE Poet
i toread
.
Sk b T Ceden i
.
|
|
I
Barss Fordd ] i
| (o T = 1
[ aetmn | [ = e |

Click this icon is to save current settings as a TXT file for later uses;

e @[

Click this icon is to import stored setting file at once.
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2. Book Panel

ElBock
_ide Book Frame Bar
BlBook Proportions
_ TopMargn
_BottomMargin

_ leftMargn
RightMargin

L= B = =

L=}

":Efage Shadow

_ RightToleft
.. Hard Caver |

_BookTife |wwwFipB..

Retain the bockto center [No

__Flash Window Color | l0x021A25
Page Background Color | CTOXfFFf

Backgrgund anﬁg e L e

#lipﬁiﬁg"ﬁﬁ]e ] e

(1) Book Title (only can be set in Float Template)

Customize book title for showing on the top of your flipbook.

(2) Hide Book Frame Bar

| Hide Book Frame Bar |fes

If don’t want to show the book frame bar, choose “Yes” in this option.

(3) Retain the book to center

| Retain the book to center [Ves

If you select “No” in this option, the eBook will be shown on the right-side. This setting is for embedding
special background image, such as advertisement or company log.
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(4) Book Proportions

 Ei300k Progartons |
Page Vidth 55 |
Page Height 842 |

Please note that the values are not fixed in pixels or inches, they just represent a ratio for "Page Width:
Page Height", and the book size will be changed depend on your Explorer Window Size.

(5) Book Margin

A. Book Margin (set in Classical Template):

e ——

"Book Margin_" refers to the distance between the book and the toolbar.

B. Top/ Bottom/ Left/ Right Margin (set in Float/ Spread Template):
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| TepMargin 0
| Bottom Margin 0
| LeftMargin 50
| mohthwan lso

~) Bottom o

(6) Flash Window Color
|__Flash Window Color__| JOx2€3. .|

This color will be applied on all flash windows, such as the book window, "Help" window, "Print" window
and so on.

(7) Page Background Color

Page Background Color | L J0xFFF... |
[ oo o Powes:
¥ S .

When load pages, or if the page number of your WORD file is odd, then the page (the last page) will show
with the "Page Background Color".
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(8) Page Shadow
[ [

Right page Shadow 55
Page Shadow Opadty |1
Left page Shadow
—-| |

| Right page Shadow|
The value also takes the value of Book Proportions as reference, and the value interval of "Page Shadow
Opacity" is "0~1", the larger value refers to the deeper shadow color.

(9) Background Config
A. Background Color:

BBackground Color
Gradient Color A [
Gradient Color B B0x408...
Gradent Angle 20

_Gradient Color A
.

Gradient Color B
Define background for your flipbook with gradient color or pure color (the same color for "Gradient Color
A" and "Gradient Color B"). Gradient Angle is the angle between the two colors.

B. Background Image setting in Classical and Spread templates:

Click the icon "==I" to choose background image from your computer, and there are 11 kinds of "Image
Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right, Middle Left, Middle Center,
Middle Right, Bottom Left, Bottom Center and Bottom Right.
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C. Background Image setting in Float template:

Inner background image to show special information, such as advertisement or company logo, etc. There
are also 11 kinds of "Image Position" for you to choose: Scale to fit, Fill, Top Left, Top Center, Top Right,
Middle Left, Middle Center, Middle Right, Bottom Left, Bottom Center and Bottom Right.

(10) Right to Left

If the language of your file is read from right to left (such as Arabic), then choose "Yes" in "Right to Left"
option:

[ | RightTolLeft Yes

: had
Nex: Page

(11) Hard Cover
If you want create hard cover effect (a book bound with rigid protective covers) for your flipbook, choose
"Yes" in "Hard Cover" option:

-_ Hard Cover |Yes
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(12) Flipping time
Sets page flipping time in seconds according to your needs. (Recommended second value is 0.6):
Flipping Time 0.8

3. Sound Panel

ESound
Enable Sound |Enable |
Sound File roi=z. mp ke
Sound Loops o

If you want to add background sound to your flipbook, such as a song or other audio file, set "Enable
Sound->Enable", then click e icon to choose "Sound File" from your computer, then set "Sound Loops",
"-1" stands for playing the sound file all the time while viewing flipbook, other value (N>0) stands for the
times of playing the sound file.

4. Tool Bar
ElToolBar o ]
IconColor DloxffFf |
HZoomConfig e |
PrintEnable |Yfes . |
Search Button Hide

Search Highlight Color | Il0x408080 |
Least search characters |3~~~ |
ElDownicad setting
Full Screen Button  |Show
HepButton show
[ share Button
MHomeuton
BauoFip
ToolBarontop ~ |False
Page Mumber Box On B... False

(1) Tool bar (only in Classical Template)
Tool bar Shaw | Show or Hide Tool bar in created flipbook.

(2) Icon Color

Icon Color | owFrrFL =]
i e = ~ = @
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(3) Zoom Config

To enable Zoon In functionality, choose 'Yes" in "Zoon in enable", you can set "Zoom Scale" in Classical
Template, the value is the times between zoomed page size and the current page size.

(4) Print Enable
Print Enable Yes

Choose "Yes" in "Print Enable", then click icon to set print page range as below:

& Print w

= Print &8 Pages
_ Print Current Page

/) Prnt Range
Example; 2. 5,8-26

£ Print

(5) Search Button:
| Search Button |Show
....Search Highlight Color | Bl0x408080 |
Lesst search characters |3
Select "Show" in "Search Button" (make sure you have check "Enable Search" option in "Import Word"

interface), then define "Search Highlight Color" and "Least search characters", after clicking "Search" icon
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, you will see a popup box to input search words, then click Enter or "Search" button, you will get the
below searching result:

wrm | e s Pag=L _ i

— b

T b R S, e e

T N —
{ e g S b =
A S ——

(6) Download setting:

ElDownload stiing
Download Enable Yes
| Download URL PPTDemo.ppf

If you want your flipbook readers to download the Word file or the flipbook directly from your website,
select "Yes" in "Download Enable" option, then input the Download URL directly, you can use absolute path
like "http://www.flipbuilder.com/flip-Word/example/files/download/FlipWORDDemo.doc" or relative path
like "/files/download/Flip®WWORDDemo.doc" (make sure you have uploaded the WORD file to the same path).

Then readers can click the icon n to download your uploaded WORD file directly.

(7) Full Screen

To enable "Full Screen" functionality in output flipbook, select "Show" in "Full Screen Button" option:
Full Screen Button | Shaow

Then you can click icon Eto view flipbook in Full Screen, click icon m or "Esc" button to exit from
the Full Screen.

Or if you want to show your flipbook without Tool Bar while showing in Full Screen mode, you can set "No"
in "Full Screen without Tool Bar" (just in Classical Template): . Ful Sereen Without Toal.. |Yes

(8) Help Button

To show tips about viewing flipbook, you can set "Show" in "Help Button"
option: . Help Button |Shaw
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Then you can see the button and click to get the tips as below:
"  Help x

'4\" Double click to zoom in or out

ﬂ( Drag the page corner to view

(9) Share Button

If you want your flipbook viewers to send the link to their friends or clients, you can add a share button in
your flipbook for readers to send out your flipbook link immediately:
Elshare Button

Share Button Shnjﬁ
‘Email Subject Reear my fii...
Email Body fink}

When the viewers click the share buttonE, they will enter into the Email interface with the link of your
flipbook in the Email body.

(10) Home Button

You can add a home butt_onm to help reader to click and go to your website directly:
ElHome Button _
Home Button Visible Show
Page LIRL htip:/{flipbuil. ..
Open Window Blank

(11) Auto Flip

IR e

R e AR

v i Interval 03
_Play Count -1

_ Autofipwhenstartup [Yes
To auto flip your eBooks, you can set "Yes" in "Auto Flip->Enable" option; then define the Flip Interval
(seconds of staying on each page); the value of "Play Count" stands for the times of auto playing the eBook,

and "-1" stands for playing forever (after clicking the Auto Flip button “, the flipbooks will be flipped
by staying 3 seconds per page); if you want to auto start and flip the eBook after opening, just set "Auto flip
when start up->Yes":
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(12) Tool Bar on Top
Tcu:ul Bar on top TF'-I_E

(13) Page Number Box on Bottom

Page Numl:uer Eh::ux Cln B . | True

5. Initial Show (set in Float/ Spread Template)

You can show Bookmark panel or Thumbnails panel on the flash page at the beginning, just select
"Bookmark" or "Thumbnails" in this option:

| Initial Show | Thumbrails |

For Example, select "Thumbnails":

Then you will get flipbook shown with below initial interface:

6. Bookmark
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E.
"_l'l_ Aboul Fip wod 2
'] Product lnshue: k|
__E._E Bage-lippirg efock festures 5
] Quick. Sten L

L] Iriteifacet 3
_1 Luserns dogiaament n

'] How to Ordes 32
| Srappar 13

In "Design Setting" panel (only in Classical Template, in other templates, the colors will be adjusted
automatically based on your defined flash window color), you can set "Font color", "Background color",
"Background alpha" (refers to the background opacity, value interval: 0~1, "0" stands for the background is
totally transparent), "Always Show Bookmark->True/ False" and "Panel Position->Left/ Right".

In "Bookmark" panel, if you didn't check "Import bookmark" option in "Import Word" interface, or you
want to create new bookmarks for your flipbook, you can add bookmarks even sub-bookmarks here, click
"Add" icons and then input "Title" and "Page".

When click the bookmark button, it will popup the bookmark panel immediately, and click on those
bookmarks, it will jump to the defined page automatically.

7. Links

[

If you have check "Import links" option in "Import Word" interface, then you can define settings here,
choose "Mouse over color”, "Link alpha" (refers to the link area opacity, value interval: 0~1, "0" stands for
the area is totally transparent), "Border color", "Border width" and "Open Window->Blank/ Self". The links
also can be clicked after zooming by setting "Enable after Zooming in->Enable".
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8. Language

|_Langusge |English |

You can set language for showing tools or tips in your created flipbook, and here is the specialized
instruction page for setting the "Language Option".

9. Security Settings

[ Security Settings Single Pas: ]

If you want to protect your flash books with passwords, you can click "..." icon to enter into "Flash Security
Config" interface: ‘

‘@ Flash Securty Config. ]

Mobe:
Sngha Password oplon means that users need the password to view the fash book,

Exgude Frant Pages apbon is to set a page number, all latter pages can't be
wiewed without inputting password.

Security Type

Ho Security

I |
(AN
@ Singie Paseword: 173456
Protect Page Range
| & Al Pages

I Exdude Front Pages

| C= ] o=

Select "Security Type->Single Password", and input passwords into the box (there is no restriction on
password format at present). You can also set "Protect Page Range" as "All Pages" or the latter pages after
a defined page number. (Tips: The program utilize RC4 algorithm to protect eBook pages, the eBook
content pages will show nothing without permission.)

10. Font
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Product features

Fomtcdor N
_ Button Font

 MWindowFont
. Bookmark Font Color |
Bookmark Font

License Agreements

Hrw to Order

If you want to change fonts of toolbar buttons, flash windows even bookmarks, you can set font types and
colors in Font Panel.

11. Google Analytics

Gnﬁgle Analytics ID

In the HTML output format, you can add statistics by using google analytics. You can get more information
about Google Analytics ID from http://www.google.com/analytics/ .

(e &pplvﬂmnﬂEi

At last, click ! icon to apply the settings.

IV. Language Options Interface

Click "Option->Flash Language", you will enter into the Language Settings interface as below shows:
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You can new or edit a language for the flash fiipping book.
The: Labled column below is the string that will be displayed in the flash.
It} The language will be list in the fiash template setlings

e - - . —
Language Name: [Engish v) [# tewianguage| [ $peete | (B sovens.,| [ Galioed. |
Language Sethings |
Label Labled - [ B
First Button First
Next Page Button Next Page £
Last Button Last
Frevious Page Button Previous Page A '
Dowrioad Button Dowriload
Prink Button Print
Searth Button Search
Bogk Mark Bution Book Mark
Help Button Help |
Enable FulScreen Button  Enable FulScresn
Disable Fullsreen Button Disable FullScreen
| Graimd i Bt G i 2

Panel Description:

As the tips explaining, the "Labled" column lists the buttons and instructions on Flash books in defined
language, and the program provides you five different languages for you to use: English, Chinese Arabic,
French and Greek.

Language Name: Em "J

Arabic

You can also add other language for your own uses:

1. Click the button[ g Hew tanguage i_and define name for the new language:
(2] New Language p— |

New Languags |

Name: French

Copy From: | English -

L ] [emw ]

Click "OK" to save the new language in the list;
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2. Choose the first label and click "Edit" icon, define new language text in "Labeled" box, then click "Save
And Edit Next":

Language Settings
Next Page Button L
Last Butten Last i Edii Language ltem -
Frevious Page Button Previous P —————————
Dowrload Buttan Download || B3t Lengiage Strig |
Print Button Print
Saarch Buttan Sasarch Label 1 FirstButton
Bt Mark Button Beok Mark Y ]
reelo Button Felp Labeied:  Presménel
Enable FulSoreen Button Enabie Fuls
[ieabie Fulscreen Button  Desable Fult
| S O Bustbnes, smmdrn |l
[_&-vuwsdnum | | Cancel
] =

3. At last, you can get all Labels translated into your new language as the images shows:

Label Labled

First Button Premiére

Mext Page Button Page suivante
Last Button Derniére

Previous Page Button Page précédente
Download Button Télécharger

Print Button Irnprimer

Search Button Rechercher

Book Mark Button Réserver Mark
Help Button Aide

Enable Fullscreen Button Activer FullScreen
Disable FullScreen Button Désactiver FullScreen
S Tim Bt e Craumd

Delete
You can delete unwanted language:

Or save your edited new language file as XML or TXT file:
33 Load...
Load language file saving before for current using:
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V. Output Interface:

;rij Cutput Option e
| output |

Output type

e
p— ja g — z ..
@ @ *.html = B *zp {:ﬁ T = exe

[¥] Also Make Mobile Version  Make output page-fipping eBook works on iPad, iPhone and Android mobile devices

Path
Qutput Folder: C: \J_lsers\,ﬂ.dminisfrai:or\,[]ocumenﬁ I Browse. .. | [ Open
File Mame: index Jhtml
Options
HTML Title: Microsoft Word - Document1 .'_;‘ Advanced
[ Burn to CD

= |0:1:0,G: PLDS  DVD-ROM DH-16055 VD15

Make it autematically play the flipbook in CD

[ Cancel J I LConvert |

Output types:

1. HTML

9 oo

This output type is for uploading created page-flipping ebook onto websites:

You can define HTML Title and other properties by clicking "Advanced" button:
Options

HTML Title: ‘demo ,Ja“ &dvanced‘

Set Keywords, Description or even Script in the below interface:
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@-ﬁdwn::d Settings ﬁ

HTML Advvanced Sattngs

HTML Meta Sattings
Titla: Flip Word Introducton
Keywords:  corvert, ward, doc, fipbook, page-fioping, shock, flash, template, security

Descrighon: o word is & tood to convert Word fies to nicelpage-fippng ek with ease,

Add Soripts
o 2B pul soms tracking
code mch a5 Googie
Analybcs here,
Reed dosed csarpt>tagl
o] | Cancel
2.ZIP
B o
&l

This output type is for compressing the created files into an integral ZIP package which can be sending out
as attachment directly. You can also define HTML Advanced Settings by clicking "Advanced"

e demo html

baok.st

This type is for outputting flipbook as a single executive file, easy storing and easy viewing:

—_—
=2

| demo.exe

You can also define Icon and Opening Window Size in Advanced Settings:
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o v
| Adh i
@ vansed Settings fax |
Exe advenced Setbings
Exe Window Info

Capbien:  Fip Word Introducton

Windew e Cobon

) Mawenged Custom Sae B0 |

You can even output Mobile Version at the same time:
i E_Alsc; Mallce.r\':lﬁilj-iiel\a'ersion l
After creating mobile versions, you just need to output all files online (including HTML, SWF, "files" and

"mobile" folders), then you can visit the flipbook page through your mobile browser.

Or even burn the output flipbook to CD:

CD Writer |0:1:0,G: PLDS  DVD-ROM DH-16D55 VD15

Disc title: |Page-Flipping eBook

[¥] Make it automatically play the fiipbook in CD

After choosing output type, then check the option "Burn to CD", set "CD Writer", define "Disc title", at last

C t
click button to output flipbook in your defined type.

At Last
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With Flip Book Maker for Word, you can easy create beautiful and professional
page-flipping eBooks within a few seconds.

Now, use the wonderful to produce your style stunning page-flipping eBooks.

For more information: http://www.flip-book-maker.com/
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